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Oral Theophylline Kinetics: 

The One-Compartment Model with Absorption 
 
Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this case study 
 

• How to create the one-compartment model with absorption to analyze rising 
and falling data. 

• How to obtain initial parameter estimates for the model. 
• How to write the noncompartmental parameters for this model. 
• How to identify the two solutions that exist for this model. 
• How to select the solution to the model that is most appropriate using a priori 

knowledge of the system being studied. 
• How to keep track of your modeling session using Notes. 

 
Files Required 
 

Data: 
The data file for this case study is 
 

theo_oral.dat 
 
Introduction 
 
This case study will show you how to create a one-compartment disposition model with 
absorption represented by a second compartment, and show that the model has two 
solutions. Based on modeling theory, this model is not a priori identifiable (see [1] for 
example), and one must decide which of the two solutions is most appropriate for the 
particular study. The data used in the case study come from a report in which plasma 
concentrations (μg/mL) were measured after oral administration of a 320 mg theophylline 
dose to healthy subjects [2]. 
 
Since the 1930’s theophylline has been used as a bronchodilator to treat patients with 
bronchial asthma. It has a narrow therapeutic plasma concentration range. In addition, the 
pharmacokinetics varies widely among subjects, primarily because of differences in 
elimination clearance rather than distribution volume.  
 
When theophylline is administered to humans by intravenous infusion, the drug exhibits a 
two-compartment or three-compartment pattern of distribution. When given orally with 
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typical blood sampling protocols, these compartments collapse into a single disposition 
compartment. In either case the distribution volume of theophylline, based on 
measurement of free + protein bound drug in plasma, is greater than extracellular fluid 
space but somewhat less than total body water because theophylline binds to plasma 
proteins [3].  
 
This case study will also discuss how to employ a priori identifiability to obtain the most 
appropriate solution to a model where more than one solution exists. 
 
The problem addressed in this case study can be summarized briefly: I have performed a 
study to estimate the pharmacokinetic parameters of theophylline. Based on the data, I 
want to use a one-compartment disposition model with absorption to describe the kinetics 
and estimate the parameters. This is because the data rises and falls, and I believe that this 
compartmental model will be satisfactory. I have heard this model has more than one 
solution, and don’t know what to do about it. What are my options? 
 
1. Cobelli, C., Foster, D. and Toffolo, G. Tracer Kinetics in Biomedical Research. 

Kluwer Academic/Plenum Publishers. New York. 2000. 
 
2. Upton, R. A., Thiercellin, J. F., Guentert, T. W., Wallace, S. M., Powell, J. R., 

Sansom, L., and Riegelman, S. “Intraindividual variability in theophylline 
pharmacokinetics: statistical verification in 39 of 60 healthy young adults.” J. 
Pharma. and Biopharma. 1982, 10: 123-134. 

 
3.  Belknap, S.M. Nelson, J.E., Ruo, T.I., Frederiksen, M.C., Worwag, E.M., Shin, S.-G., 

Atkinson, A.J., Jr. “Theophylline distribution kinetics analyzed by reference to 
simultaneously injected urea and inulin”. J. Pharmacol. Exp. Ther. 1987, 243: 963-
969. 

 
 
Part 1. Create the two-compartment model (one-compartment model with 

absorption). 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. In the SAAM II Toolbox, click Model to be sure these tools are available. 

 
3. Create the following system model on the Drawing Canvas: 

 

 

©University of Washington Oral Theo - 2 Rev 08/10/13 



Pharmacokinetic Case Study   Oral Theophylline Kinetics 

 
 

Part 2. Create the pharmacokinetic experiment on the model. 
 
1. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog 

box will open. 
 

a. Enter “25” in the End At box. 
 

b. Type “hours” in the Units box. The Experimental Attributes dialog box will 
appear as follows: 

 

 
 

c. Click Done. The Create Experiment dialog box will open. 
 
d. Be sure “Experiment” as the Type is selected. Click Create. 

 
2. Add the data to your model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 

b. In the File menu, click Open. The file theo_oral.dat should appear in the list 
(if it does not, find the folder where you have put this data file). 

 
c. Double-click theo_oral.dat. The data in this file will appear in the Data 

window. You may receive the following warning message. If you do, click 
OK. If you do not, the Data window will appear as shown below: 
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 Warning messages. SAAM II will return warnings when it detects a problem 
with your model. In the case of the Data window, SAAM II expects no spaces 
at the end of the file. If you put your cursor at the end of the data file, you will 
see there may be spaces. Delete these spaces. To check that your data are 
okay, in the Edit menu, click Check Data Format. If the problem has not 
been fixed, a warning will appear. If it has been fixed, you will receive 
notification the data format are okay (message will appear at the lower left of 
the Data window.) 

 
 

 
 

The weighting scheme is SD so you can leave the variance model set as the 
default data-relative. 
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 Entering comments in a Data file. You can enter comments in your data file if 
you precede each line with “#.”In this data file, comments are provided which 
give some information about the study. In addition, the equations for the 
noncompartmental parameters are entered as comments. This is for 
convenience; later in the case study, these will be pasted into the Equations 
window. 

 
 

d. Close the Data window. 
 

3. Create the sample on the Compartment 2. 
 

a. In the SAAM II Toolbox, click Sample. 
 

b. Click Compartment q2, and then click on the Drawing Canvas. The sample 
s1 will appear. 

 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “mcg/ml” in the Units box (mcg/ml is micrograms per ml.) 
 
e. Type “cp” in the Associate with Data Name box. (Notice “cp” is in lower 

case.) 
 
f. Edit the sample equation “s1=q2” to read “s1=q2/vol”. The Samples 

Attributes dialog box will appear as follows: 
 

 
 
g. Click Done. 

 
4. Create an input into Compartment 1. 
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The dose of theophylline was 320 mg. Since the units of the data are in μg/ml 
(mcg/ml), the dose must be consistent with the data. Thus the dose is 320,000μg. 

 
a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1, and then click on the Drawing Canvas. The input ex1 

will appear. 
 

c. Double-click ex1 to open the Exogenous Input dialog box. 
 
d. Be sure bolus is selected as the input type and enter “320000” in the Initial 

Amount box. 
 
e. Click Add. The Exogenous Input dialog box will appear as follows: 
 

 
 
f. Click Done. 

 
Part 3. Defining Derived Variables (Noncompartmental parameters). 
 
The parameters for your model are the rate constants k(2,1), k(0,2)  and the volume vol. 
The rate constant k(0,2) is a fractional measure of the elimination rate of the drug, and it 
has units of inverse time (in this case, 1/hour). It is usually of interest to calculate the 
elimination clearance of a drug. This is defined as the product of the elimination rate 
constant and the volume of the compartment from which the elimination rate constant 
exits. In other words: 
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Cl = k(0,2) * vol 

 
Although elimination clearance Cl is derived as a function of the primary parameters 
k(0,2) and vol, it provides a volume-independent estimate of drug elimination. As you 
recall, parameters are variables that appear in the equations characterizing the model or 
experiment, but were not given numerical values. SAAM II automatically determines the 
model parameters. Following a successful “Fit,” the model parameters and the derived 
variables will appear in the Statistics window. 
 
Besides clearance, there are a number of other noncompartmental pharmacokinetic 
parameters that can be estimated using the one-compartment model with absorption: 
 

Tmax = log((k(2,1)/k(0,2)))/(k(2,1)-k(0,2)) 
Cmax=(dose/vol)*exp(-k(0,2)*Tmax) 
Elim_t_half=log(2)/k(0,2) 
Abs_t_half=log(2)/k(2,1) 
AUC=dose/(vol*k(0,2)) 
AUMC=dose/(vol*k(0,2)*k(0,2)) 
MRT=AUMC/AUC 
MAT=1/k(2,1) 
Vss=Cl*MRT 

 
You can enter these parameters directly. For convenience, they can be cut and pasted 
from the data file to the Equations dialog box as described below. 
 

1. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar click 

Data . The Data window will open. 
 
2. Select and copy the noncompartmental parameters. The selected information will 

appear in the Data window as follows: 
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3. Close the Data window. 
 
4. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 

click Equations . The Equations dialog box will open. 
 
5. Paste the equations in the Equations Defined Here pane in the Equations dialog 

box. 
 
6. Remove the “#” from the beginning of each noncompartmental parameter 

equation. The Equations dialog box will appear as follows: 
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 Equation syntax. There are two points to remember about equation syntax in 
SAAM II. First, while it may be appealing to define half time as t_1/2, this is 
improper syntax, and SAAM II will display an error message. The other point 
is that the natural log is “log”, not “ln.” If you define, for example, 
t_half=ln(2)/k(0,2), “ln(2)” will be interpreted as a parameter instead of an 
algebraic operation, and will appear as a parameter in the Parameters dialog 
box. 

 
 
7. Close the Equations dialog box. 

 
Part 4. Enter the parameter values, solve the model, fit the model to data, view the 

solution and record the results. 
 
Before you can Solve (simulate) your model or Fit your model to your data, you must 
provide numerical estimates for the primary parameters of your model. These are the 
parameters that appear in the Parameters dialog box. 
 

1. Enter the parameter values. 
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a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameter . The Parameters dialog box will open. Notice 
that dose appears as a parameter. This is because dose is used in some of the 
calculations for the pharmacokinetic parameters. 

 
b. If dose is not selected, double-click dose to select it. Select the Fixed option. 

Enter “320000” in the Value box and click Save.  
 

 Dose as a parameter. In this case study, dose will be entered both as a 
parameter and in the Exogenous Input dialog box as the amount of the bolus 
injection. It is entered here as a fixed parameter because it is used in the 
calculation of some of the noncompartmental parameters. It should be noted 
that the bolus in the Exogenous Input dialog box could also be specified as 
an equation where, in this case, “ex1 = dose” with the starting and stopping 
times of zero. 

 
 
c. Double-click k(0,2). Enter “0.08” in the Value box and click Save. 
 
d. Double-click k(2,1). Enter “1.75” in the Value box and click Save. 
 
e. Double-click vol. Enter “300000” in the Value box and click Save. The 

Parameters dialog box will appear as follows: 
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f. Click Done. 
 

 Initial parameter estimates. How the initial estimates for the parameters k(2,1), 
k(0,2) and vol are obtained is explained in the appendix to this case study. 
This approach can be applied to any experiment in which you are using the 
one-compartment model with absorption. 

 
 

2. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 

b. Plot the data. In the Show menu, click Plot, or alternatively, on the SAAM II 

Toolbar, click Plot . 
 

c. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 
dialog box will open. Be sure the List All Variables box is cleared. 

 
d. Click “s1:cp” to move it to the Current Selection pane. 
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e. Click Done. If your plot does not appear in semi-log mode, in the View menu, 
click Semilog. Your plot will appear as follows: 

 

 
 

While the shape of the model predicted values follows the data fairly well 
meaning that the estimates for k(2,1) and k(0,2) are reasonable, you can see 
that  the estimate for vol is off. This causes the model predicted values to lie 
below the data and means the estimate for vol is too large. Since the maximum 
difference between the data and model predicted values is about a factor of 10, 
you should reduce your estimate for vol by a factor of 10 from 300,000 to 
30,000. 

 
f. Open the Parameter dialog box, set the initial estimate for vol equal to 30000 

and reset the Low and High limits respectively of 3000 and 300000. Re-Solve 
the model. Your plot should appear as follows: 
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Now the model predicted values do not differ that much from the data. The 
initial rise is not fast enough meaning that the estimate for k(2,1) is low. 
Should you wish to continue hand-fitting, you can increase this to see how the 
solution is affected. When you hand-fit your model to your data, a rule of 
thumb for increasing or decreasing rate constants is a factor of two. Thus if 
you increase a rate constant, multiply it by 2, and if you decrease it, multiply it 
by ½. 

 
g. Leave the Plot window open. 

 
3. Fit your model to your data, and view the solution and statistics. 

 
a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar 

click, Fit . 
 
b. Since your Plot window is already open, your plot will appear as follows: 
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The “Fit” is satisfactory in that there are no obvious systematic deviations 
between the model predictions and the data with the possible exception of the 
final datum which appears to be low. Since this datum is at 24 hours which is 
12 hours after the previous datum, it is possible that it is an outlier. It is also 
possible that the value is reaching the level at which the amount of drug in 
plasma cannot be quantitated with the same accuracy as the earlier data. 
 

c. In the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar 

click, Statistics . The Statistics window will open as follows: 
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You can see that the statistics are quite reasonable in that no parameter has a 
large error. You will have to scroll through the Parameter/Variable pane to 
see all of the pharmacokinetic noncompartmental parameters. 
 
Notice that the estimated volume of Compartment 2 is 34,316 ml, or 34.32L. 
For a 70 kg individual, this is 0.49L/kg, or just under 50% of body weight. 

 
4. (Optional) Record the results in the Notes window. 

 
a. In the Show menu, click Notes, or alternatively, on the SAAM II Toolbar 

click Notes . The Notes window will open. 
 
b. Type “First fit – rapid absorption and slow elimination.” 
 
c. In the Statistics window, select all the information for all the parameters.  
 
d. In the Edit menu, click Copy. 
 
e. Click in the Notes window. In the Edit menu, click Paste. 
 
f. In the Statistics window, select and copy the information for the objective 

function. 
 
g. Click in the Notes window. Click below the statistical information. In the Edit 

menu, click Copy. Your Notes window will appear as follows: 
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h. Close the Notes window. 
 
Part 5. Fit the model to data with another set of initial parameter estimates, view the 

solution and record the results. 
 

The purpose of this part of the case study is to show that another set of initial 
parameter estimates will lead to an identical solution in terms of the fit but a different 
final set of parameter values. The difference here is slow absorption and rapid 
elimination, as opposed to the above where the absorption was rapid and elimination 
was slow. This is an example of so-called “flip-flop” kinetics that may be 
encountered when an extended release formulation of a drug is administered. 

 
1. Open the Parameters dialog box, and change the values as follows: 
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2. Solve the model, and view the solution. Your plot will appear as follows: 
 

 
 
3. Fit the model to the data, and view the solution and statistics. 
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a. Fit the model to the data. The plot will appear as shown below (Notice that 
this “Fit” is identical to the previous “Fit”): 
 

 
 

b. In the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar 

click, Statistics . The Statistics window will open as follows: 
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You can see that the statistics are equivalent to those of the previous “Fit” and 
that the value of the objective function is the same. In addition, the precision 
of the model parameter estimates is similar. 
 
What about the pharmacokinetic parameters? It is interesting to see which are 
different. Those that remain the same, Cmax, Tmax, AUC and Cl, are 
expected. However, the two model solutions resulting from the different initial 
values of the parameter have a dramatic effect on parameters characterizing 
absorption and elimination.   
 
 

4. (Optional) Record the results in the Notes window. 
 

a. In the Show menu, click Notes, or alternatively, on the SAAM II Toolbar, 

click Notes . The Notes window will open. 
 
b. Under the information from the first “fit”, type “Second “Fit” – slow 

absorption and rapid elimination.” 
 
c. In the Statistics window, select all the information for all the parameters.  
 
d. On the Edit menu, click Copy. 
 
e. Click in the Notes window. In the Edit menu, click Paste. 
 
f. In the Statistics window, select and copy the information for the objective 

function. 
 

g. Click in the Notes window. In the Edit menu, click Paste. Your Notes 
window will appear in part as follows: 
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h. Close the Notes window. 

 
 

 Flip-flop kinetics. When you use this model to analyze your data, you must be 
aware that there are two solutions that give the same “Fit” to the data. Which 
solution you achieve will depend upon your choice of initial parameter 
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estimates. The difference in the two solutions is rapid absorption and slow 
elimination versus slow absorption and rapid elimination. 

 
 One can often choose the “correct” model based on the volume parameter. 

One may know, a priori, that the volume of distribution for a particular drug 
should be some known percentage of body weight, for example. There are 
cases when the choice for the volume may not be so obvious. This could 
happen in studies at the organ or cellular level.  

 
 In this case study, the volume of 34.3 L or 0.49 L/kg obtained for 

compartment 2 when absorption rate is more rapid than elimination agrees 
with the expected distribution volume of 0.5 L/kg expected for theophylline 
(see tables in the Goodman and Gilman text).  On the other hand, the second 
volume of 11.39 L or 0.16 L/kg for compartment 2 resulting from slow 
absorption and rapid elimination is unrealistic, so the correct choice would be 
the model with rapid absorption and slow elimination. 

 
 

If you wish, you may save the study file for future use. You can use this study file as a 
template for other sets of data you wish to analyze using the one-compartment model 
with absorption.  
 
Quit the SAAM II Compartmental application. 
 
Essential Points to Remember 
 

• This very simple one-compartment model with absorption used to explain the 
kinetics of a drug administered orally has two solutions. 

• If your model has more than one solution, when you fit your model to your 
data, the solution that you obtain depends upon how you choose your initial 
parameter estimates. 

• If you use this model, then you must choose the “correct” solution based upon 
additional information about the system you are studying. 

• In this case study we have assumed that the oral dose is completely absorbed 
(F = 1.0 where F is the parameter for fraction absorbed). If this is not the case, 
we can only estimate relative clearance and distribution volume as CL/F and 
V/F. The fact that expected value for the volume of compartment 2 was 
obtained with the rapid absorption model not only supports this model choice 
but indicates that the oral absorption of this theophylline formulation is 
essentially complete. 

 
Modeling Notes 
 
What happens in this situation? There are ways to choose one set of parameter values 
over another, but this relies on additional information about the drug and subjects being 
studied.  

©University of Washington Oral Theo - 21 Rev 08/10/13 



Pharmacokinetic Case Study   Oral Theophylline Kinetics 

 
You can see why there are two solutions to this model by performing an a priori 
identifiability analysis on the model. You can do this by solving the system of differential 
equations that the model represents.  
 
Remember that the data in this case study can be “Fitted” to the two-exponential model, 
 

y(t) = A(exp(−a * t) − exp(−b * t))
  

If  is the amount of the bolus injection, then the solution for qd 2 (t )  for the differential 
equation represented by Compartment q2 is 
 

))2,0(exp())1,2((exp(
))1,2()2,0((

)1,2()(2 tktk
kk

kdosetq ⋅−−⋅−
−
⋅

=  

 
Using the measurement equation s1=q2/vol, one has 
 

 
))2,0(exp())1,2((exp(

))1,2()2,0((
)1,2()(1 2 tktk

kkvol
kdose

vol
tqs ⋅−−⋅−

−⋅
⋅

==
 

 
The relationship between s1 and y(t) will show why there are two solutions for this 
model. Since they both describe the same set of data, s1 = y(t)! This means the 
coefficients for the sum of exponentials must be the same, and the exponentials and rate 
constants k(i,j) are the same. 
 
More specifically, if the exponential has been “Fitted” to the data, then 
 

A
kkvol

kdose
=

−⋅
⋅

))1,2()2,0((
)1,2(

 
 
from which vol can be found. 
 
It is easy to see that k(2,1) and k(0,2) play interchangeable roles as you observed in the 
“Fitting” exercise above. That is, since the data in this case study can be “Fitted” to the 
two-exponential model, 
 

y(t) = A(exp(−a * t) − exp(−b * t))
  

you can interchange “a” and “b”, and write 
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))exp()(exp))1,2(exp())2,0((exp(
))2,0()1,2((

)1,2( tbtaAtktk
kkvol

kdose
⋅−−⋅−⋅=⋅−−⋅−

−⋅
⋅  

 
from which you have 
 

d ⋅ k(2,1)
vol ⋅ (k(2 ,1) − k(0,2))

= A  

 
The two cases you observed during the two “Fitting” processes can now be explained. In 
case 1, k(2,1) = a and k(0,2) = b, and you can solve for vol. In case 2, k(2,1) = b and 
k(0,2) = a, and you can solve for vol. 
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Data for this case study 
 
DATA 
#Dose: 320 mg/kg  Wt. 70.5kg 
#Units: mcg/ml 
(SD 1.0) 
t cp 
0 0 
0.27 4.4 
0.58 6.9 
1.02 8.2 
2.02 7.8 
3.62 7.5 
5.08 6.2 
7.07 5.3 
9 4.9 
12.15 3.7 
24.17 1.05 
END 
# 
#  Equations for the noncompartmental parameters 
#Tmax = log((k(2,1)/k(0,2)))/(k(2,1)-k(0,2)) 
#Cmax=(dose/vol)*exp(-k(0,2)*Tmax) 
#Elim_t_half=log(2)/k(0,2) 
#Abs_t_half=log(2)/k(2,1) 
#AUC=dose/(vol*k(0,2)) 
#AUMC=dose/(vol*k(0,2)*k(0,2)) 
#MRT=AUMC/AUC 
#MAT=1/k(2,1) 
#Cl=vol*k(0,2) 
#Vss=Cl*MRT 
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Appendix: Obtaining Initial Parameter Estimates for a 
Two-Compartment Model with Input into One Compartment and 

Samples from the Second Compartment  
(the One-Compartment Model with Absorption)  

 
  
The situation described in this appendix is one in which data, normally plasma, are rising 
and falling following a bolus injection of drug, normally into a compartment other than 
plasma. The typical situation is oral administration of a drug as a tablet with plasma 
samples; it is the so-called one compartment model with absorption. 
 
This appendix assumes you are familiar with the notion of half-life, and how it is used to 
estimate the rate constant of the one-compartment model following a bolus injection or 
constant infusion. This is explained in the Appendix to the case study on cadralazine 
kinetics. 
 
The two-compartment model is the following: 
 

 
 
The rate constants to be estimated are k(2,1) and k(0,2) together with the volume term, 
vol, if the sample equation is s1=q1/vol. The exponential model for this situation is 
 
  (1) 0)( 2121

21 =+⋅+⋅= −− AAeAeAty tt αα

 
In this appendix, you will learn how to obtain the initial estimates for both the 
compartmental and exponential model. 
 
If you plot the data in theo_oral.dat in semi-log form, connect the data using the Line-
Plot option in the View menu, and set the Plot/Table Scale Y axis  from 1.0 to 15, you 
will obtain 
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These data are classical rising and falling data. The falling portion of the curve appears to 
be decaying monoexponentially.  
 
How can you use the notion of half-life to obtain initial parameter estimates?  It is clear 
for the decaying portion of the data, that you can simply draw a straight line through the 
data and estimate the half-life as you did for the one-compartment model following the 
bolus injection. To obtain the second parameter estimate, you can simply draw a tangent 
line to the rising portion of the curve as you did for the one compartment model 
following a constant infusion. This is illustrated in the following figure: 
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For the terminal slope, the time it takes to go from “6” to “3” is about 8.5 hours for a 
half-life of ln(2)/8.5, or .08. For the initial rise, the time to go from “3” to “6” is about 0.4 
hours for a half-life of ln(2)/0.4, or 1.75. Estimates for k(2,1) and k(0,2) are thus 1.75 and 
0.08. Obviously this supports rapid absorption and slow elimination. 
 
There are no set rules for obtaining an estimate for the volume vol, but the following rule 
of thumb often works (it may require some hand adjusting). Remember that the dose is 
320 mg and the units of the data are μg/ml. An estimate for vol can be obtained by 
dividing the dose, in this case 320 mg or 320,000μg, by the point where the decaying 
slope intersects the y-axis, in this case 0.9μg/ml. An estimate for vol is thus 300,000/0.9 
which is about 300,000 ml. This is obviously too high and will require some hand-fitting. 
 
The other way to estimate vol is to take advantage of knowing the subject’s body weight. 
Extracellular fluid space is approximately 16% of body weight, and total body water is 
about 65% of body weight. The subject here weights 70.5 kg, so expected extracellular 
fluid space and total body water are respectively 11,300 ml and 45,825 ml, or 11.3 L and 
45.8 L. For theophylline we can expect that vol will lie somewhere between the expected 
volumes for extracellular fluid space and total body water (for further explanation see 
reference 3 above). 
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In summary, the steps in obtaining the initial estimates for the one-compartment model 
with absorption are: 
 
• Plot the data on semi-log paper. 
• Draw a straight line through the decaying data; extend the line to intersect with the y-

axis. 
• Calculate the half-life t1/2 as described above; this provides an estimate for k(0,2). 
• Note where the line intersects the y-axis. Dividing the dose by this number provides 

an estimate for V1 (remember to keep the units consistent.) 
• Draw a straight line through the rising data.  
• Calculate the half-life t1/2 as described above; this provides an estimate for k(2,1). 
 
If you are fitting (1) to the data (written again for convenience below as (2)) 
 
  (2) 0)( 2121

21 =+⋅+⋅= −− AAeAeAty tt αα

 
estimates for A2 and α2 are obtained by analyzing the decaying data. The estimate for α2 
is 0.08 and A2 is the intercept with the y-axis, 0.9. The estimate for α1 comes from the 
rising portion of the data and hence is 0.35. Since A1 + A2 = 0, an estimate for A2 is - A1, 
or -0.9. Because of the constraint equation A1 + A2 = 0, one needs to estimate only A1 or 
A2. 
 
An important point to note is the following: Suppose there is a delay in the appearance of 
drug in plasma. The model changes to 
 

 
 
How is this handled? Exactly the same as above with the exception of the delay. You 
extend the initial rising portion to intersect with the x-axis; where it intersects will give 
you an initial estimate of the delay, call it tlag. To obtain estimates of the rate constant 
and volumes, or α1 and α2, proceed directly as described above. Equation (1), however, 
has to change to accommodate the delay: 
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